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DOCUMENT OVERVIEW 

using Launch by Adobe. As a companion to this guide, a reference implementation using these best practices 
can be found at:  https://aep-sdks.gitbook.io/docs/ 

Please note that the below Launch configuration will be done by Adobe Analytics Consultant. 

GENERAL LAUNCH CONFIGURATIONS & SETTINGS 

CONFIGURATION 1: CREATE A PROPERTY 
1. Click the “Add New Property” or “New Property” button:

2. Name your property and select “Mobile” as the platform.

3. By default, “Opted In” privacy settings. This can be changed later if needed.
4. Don’t change any of the Advanced Settings.

This tech spec contains basic setup best practices for implementing the Adobe Experience Platform SDK on Android

https://aep-sdks.gitbook.io/docs/
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5. Click “Save”
Your new property should display on Property list page. Click on the name of your property to open the
Overview screen and then click on the Extensions tab. Note that the “Core” and “Profile” extensions are
automatically added when you created the Property.

CONFIGURATION 2: CONFIGURE EXTENSIONS 
Start by configuring your “Core” extension that has already been installed by default. 

1. Click Configure on Mobile Core and you will see the below screen.

2. Provide your Experience Cloud Org ID. (by default this value is auto-populated using the currently
signed-in Organization ID). This is a required identifier for your Experience Cloud Organization. This is
typically, a 24-character, alphanumeric string followed by @AdobeOrg. If you need help finding it, contact
your Adobe CSM or Customer Care.

3. Optionally, provide your Experience Cloud ID Server. This is an optional server value which will be used
to send Visitor ID Service network requests to a custom endpoint.

4. Optionally, change the Session Timeout value. A default value of 300 seconds is already set. This
timeout value indicates the number of seconds that must pass after a user backgrounds the app before
we consider a launch a new Lifecycle session.

5. Click Save to confirm your settings for Mobile Core.

Configure the Analytics Extension 

1. On the Catalog tab, locate the Adobe Analytics extension and click Install.
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2. Provide extension settings 

a. Report Suites: Type one or more report suite identifiers to which the Analytics data should be 
sent. To add multiple report suite IDs, click Add Another; to remove these IDs, click Remove 
Circle. Report suite IDs can also be configured for the Development and Staging environments. 

b. Tracking Server: Provide the tracking domain to which all Analytics requests should be made. 
For help determining this – see this link.  

c. Offline Tracking: Offline tracking allows you to store measurement calls when the application is 
offline. When this box is checked, Analytics hits are queued while the device is offline and sent 
later when the device is online. Your report suite must be timestamp-enabled to use offline 
tracking. 

d. Audience Manager Forwarding: If you set up Analytics server-side forwarding to Audience 
Manager, check this setting. When this setting is enabled, all SDK requests to Analytics servers are 
sent with an expected response code of 10. This step ensures Analytics traffic is forwarded to 
Audience Manager and that the Audience Manager User Profile is correctly updated in the SDK. 

e. Backdate Previous Session Info: Enabling this setting will cause the SDK to backdate end-of-
session lifecycle information so it can be attributed into its correct session. Session information 
currently consist of crashes and session length. When enabled, the SDK will backdate the session 
information hit to 1 second after the last hit of the previous session. This means that crashes and 
session data will correlate with the correct date in which they happened. One hit will be 
backdated on every new launch of the application. For instance, if this setting is checked, 
Lifecycle session information or crash events will be backdated to one second after the last hit 
was sent. If unchecked, Lifecycle data will be attached to the first hit of the subsequent session. 
When disabled, the Adobe SDK will attach the session info to the current lifecycle. 

f. Batch Limit: This setting creates a threshold number of hits to be sent in consecutive calls. For 
example, this setting is set to 10, each Analytics hit before the 10th hit will be stored in the queue. 

https://helpx.adobe.com/analytics/kb/determining-data-center.html
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When the 10th hit comes in, all 10 hits will be sent to Analytics, consecutively. The default value 
for this setting is 0, which means that hit batching is disabled and all hits will be immediately 
sent to Analytics as they are generated. If you’re batching, you need to ensure that Offline Tracking 
is also enabled.  

g. Launch Hit Delay: Number of seconds to wait before Analytics launch hits are sent from the SDK. 
Ensure that this setting is set at 5s or greater when using acquisition functionality from the 
Mobile Services extension. 

3. Click Save. 
4. Follow the publishing process, to update SDK configuration. 
**Note: If an extension is added after the SDK has been deployed, you will need to re-install/publish the SDK 
install code (described in the next step) 

CONFIGURATION 3: GET THE SDK 
 

1. Click on the Environments tab to view instructions for adding the SDKs to an app. 

 

2. Find the platform needed in the table and click on the box icon under the Install column. You should see 
a pop up similar to below.  
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3. On the Mobile Install Instructions pop-up, choose Android 
4. Follow the instructions for using Gradle with Android 

a. Gradle Documentation: https://gradle.org/ 

Installing the SDK Manually 

In order to do a manual installation of the AEP SDK libraries, please complete the following steps: 

https://github.com/Adobe-Marketing-Cloud/acp-sdks/tree/master/android 

In order to do a manual installation of the AEP SDK .aar binaries, please complete the following steps for 
each .aar you need: 

• Download the .aar file from the Android/ directory on the master branch. 
• Go to "File > New > New Module" in the menu. 
• Select the "Import .JAR/.AAR Package" from the New Module window. 
• In the "Import Module from Library" dialog, enter the path to the .aar you are installing. 

o Enter a Subproject Name of your choice. 
• Click "Finish". 
• Once Gradle sync is complete and you see the library as a module in the Android project view, add the 

new library module as a dependency to your app. 
o Right-click on your app module, and select "Open Module Settings". 
o In the next dialog, select your app and click on the "Dependencies" tab. 
o Click on the "+" button on the bottom, and select module dependency. 
o In the next dialog, select the library module as your dependency. 

Important - note that all AEP SDK Android binaries depend on core-1.x.x.aar. 
 

INSTALL THE AEP SDK IN YOUR APP & ENABLE DEBUG LOGS 
The first step in the process is to get the SDK into the app is to get the Installation Instructions. The Installation 
Instructions for mobile Launch properties are a collection of code snippets that you need to add to specific 
locations in your mobile app. Below are the steps. 
 

1. Click on the “Environments” tab in the top navigation to go to the environments page.  
2. Development, Staging, and Production environments have been pre-created. These correspond to the 

typical environments in the code development and release process. 
3. Select the corresponding environment in which you want to install the AEP SDK and click on the box 

icon to open the code/instructions. 

https://gradle.org/
https://github.com/Adobe-Marketing-Cloud/acp-sdks/tree/master/android
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Environment IDs 

Dev: e5b7f45869ff/d78455ec7bc7/launch-c511da7c2da3-development 

Staging: e5b7f45869ff/d78455ec7bc7/launch-3848aa4ea353-staging 

Production: e5b7f45869ff/d78455ec7bc7/launch-efb05412c8d5 

Note: Reach out to adobe consulting to provide you correct Launch App ID value for development, staging and production env.



9 | Adobe Marketing Cloud Tech Spec – AEP SDK  
 

 
4. The Adobe Mobile SDK for Android uses Gradle to manage dependencies between its various 

components. Next we need to add the Adobe Mobile SDK dependencies to the app's build.gradle file. 
Below images illustrate the steps using Android Studio IDE. 

5. Copy the dependencies to your clipboard, by clicking the  icon and paste in gradle file 
Add the dependencies to your Podfile: 

implementation 'com.adobe.marketing.mobile:analytics:1.+' 
implementation 'com.adobe.marketing.mobile:userprofile:1.+' 
implementation 'com.adobe.marketing.mobile:sdk-core:1.+' 

6. Click the "Sync Now" link to sync the project 
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In next step, we need to make code changes in the App & initialize the SDK. These changes include the import 
and registration statements for Identity, Lifecycle, and Signal extensions, as well as the initialization of the 
Lifecyle metrics for Mobile Core extension. Below are the steps: 

1. Open the Main Application file of your app, which is typically “mainActivity.java”

2. In the Adobe Launch interface, scroll to the “Add Initialization Code” section. Here you will find three
icons (use the scroll bars if you don’t see it) to copy 3 different sets of code.

3. Copy the first set of import statements, click the first  icon in the “Add Initialization Code” section. 
Add Initialization Code (Change the environment code as per the environment) 

import com.adobe.marketing.mobile.AdobeCallback; 
import com.adobe.marketing.mobile.Analytics; 
import com.adobe.marketing.mobile.Identity; 
import com.adobe.marketing.mobile.InvalidInitException; 
import com.adobe.marketing.mobile.Lifecycle; 
import com.adobe.marketing.mobile.LoggingMode; 
import com.adobe.marketing.mobile.MobileCore; 
import com.adobe.marketing.mobile.Signal; 
import com.adobe.marketing.mobile.UserProfile; 

... 
import android.app.Application; 
... 
public class MainApp extends Application { 
    ... 
    @Override 
    public void onCreate() { 

super.onCreate(); 

        MobileCore.setApplication(this); 
        MobileCore.setLogLevel(LoggingMode.DEBUG); 

... 
try { 

Analytics.registerExtension(); 
UserProfile.registerExtension(); 
Identity.registerExtension(); 
Lifecycle.registerExtension(); 
Signal.registerExtension(); 
MobileCore.start(new AdobeCallback () { 

@Override 
public void call(Object o) { 

MobileCore.configureWithAppID("e5b7f45869ff/d78455ec7bc7/launch-c511da7c2da3-
development"); 

} 
}); 

} catch (InvalidInitException e) { 
... 

} 
    } 
} 

4. In Android Studio, paste these import statements before the existing imports in the main file



11 | Adobe Marketing Cloud Tech Spec – AEP SDK 

5. In the Launch interface, copy the two lines related to the Core extension, by clicking the second
icon in the “Add Initialization Code” section. The second line turns on console logging statements
(available options are "DEBUG", "VERBOSE", "WARNING", and "ERROR").

6. In Android Studio, paste these Core statements into the main file right after “super.onCreate()”.
7. If there are comments in the “try” “catch” lines, then these should be removed

8. In the Launch interface, copy the extension statements, by clicking the third   icon in the “Add 
Initialization Code” section.

9. In Android Studio, paste these extension statements into the try section.
Important Note: 
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o The 3rd code section contains an identifier like this:
MobileCore.configureWithAppID("fcee894a8eda/44b698be3873/launch-2bdc4f86f455-
development"); 

o This is the identifier of the Adobe Launch environment and the above code will import all the
libraries that are in ‘Development’ environment

o Once development and testing is complete, the changes (through libraries) should be pushed to
Production (Publish) and this code needs to be updated with the production identifier and be added
in the public facing apps

o Also, in production apps, the debug logging can be removed

ENABLE THE EXPERIENCE CLOUD ID SERVICE 
The Experience Cloud ID service provides a cross-channel notion of identity across Experience Cloud solutions 
and is pre-requisite for most implementations.  

1. Import the Identity framework in your project

import com.adobe.marketing.mobile.*; 

2. Register the framework with Mobile Core

After calling the setApplication() method in the onCreate() method, register the extension. If the
registration was not successful, an InvalidInitException is thrown.

public class MobiletApp extends Application { 
@Override 
public void onCreate() { 
super.onCreate(); 
     MobileCore.setApplication(this); 
     try { 

Identity.registerExtension(); 
     } catch (Exception e) { 

//Log the exception 
     } 
  } 
} 

After successful configuration, you'll see the Experience Cloud ID generated and included on every network hit 
sent to Adobe.  
**NOTE: If you have installed the Core extension and followed the steps of adding the SDK to your project via 
the Launch install codes, these steps have already been completed.  

PASSING VISITOR ID FROM NATIVE APP TO WEB VIEW 
In some instances, mobile applications will launch mobile web (or "webview") content within the window of the 
application.  If your app opens mobile web content, you need to take extra steps to ensure that visitors are not 
separately identified as they move between the native and mobile web in a hybrid app. 

VISITOR IDS WITHIN APPS 
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The SDK generates a unique visitor ID when an app is installed. This app visitor ID is stored within persistent 
memory on the mobile device and is sent with every hit. The app visitor ID is removed only when the user 
uninstalls the app (app visitor IDs persist through upgrades). 

VISITOR IDS WITHIN MOBILE WEB 
Typical mobile web implementations use the same standard AppMeasurement.js that is used within
desktop sites. The JavaScript libraries have their own methods of generating unique visitor IDs, which causes a 
different visitor ID to be generated when you open mobile web content from your app. 
To use the same visitor ID in the app and mobile web, complete the following instructions to pass the app 
visitor ID to the mobile web. 

1. When a webview is opened in your mobile app, call the appendVisitorInfoForURL method. See the
example below for reference:

Syntax: 
public static void appendVisitorInfoForURL(final String baseURL, final AdobeCallback<String> 
callback); 

• baseUrl is the URL to which the visitor information needs to be appended. If the visitor information is nil
or empty, the URL is returned as is.

• callback is invoked after the updated URL is available.
Code Sample: 
Identity.appendVisitorInfoForURL("http://myurl.com", new AdobeCallback<String>() {    
    @Override    
    public void call(String urlWithAdobeVisitorInfo) {

//handle the new URL here
//For example, open the URL on the device browser
//
Intent i = new Intent(Intent.ACTION_VIEW);
i.setData(Uri.parse(urlWithAdobeVisitorInfo));
startActivity(i);

    } 
}); 

By utilizing the appendVisitorInfoForURL you can append Adobe visitor data to a URL string. If the provided 
URL is null or empty, it is returned as is. Otherwise, the following information is added to the url string that is 
returned in the AdobeCallback instance: 
The adobe_mc attribute is an URL encoded list containing: 

• Experience Cloud ID (ECID)
• Experience Cloud Org ID
• A timestamp taken when this request was made
• The optional adobe_aa_vid attribute is the URL encoded Analytics Custom Visitor ID, if available

ENABLE LIFECYCLE METRICS 
Lifecycle metrics are valuable, out-of-the-box information about your app user.  These metrics contain 
information on the app user's lifecycle such as device information, install or upgrade information, session start 
and pause times, etc. Here is a complete list of metrics available using Lifecycle.  

1. Import the Lifecycle Framework

https://aep-sdks.gitbook.io/docs/using-mobile-extensions/mobile-core/lifecycle
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   import com.adobe.marketing.mobile.*; 

2. Register the Lifecycle extension

public class TargetApp extends Application { 

 @Override 
 public void onCreate() { 
     super.onCreate(); 
     MobileCore.setApplication(this); 

     try { 
Lifecycle.registerExtension(); 

     } catch (Exception e) { 
//Log the exception 

     } 
 } 
} 

**NOTE: If you have installed the Core extension and followed the steps of adding the SDK to your project via 
the Launch install codes, Steps 1 and 2 have already been completed.  

3. In the onResume function, start the lifecycle data collection:.

   @Override   
   public void onResume() {  
      MobileCore.setApplication(getApplication()); 
      MobileCore.lifecycleStart(null); 
   } 

Setting the application is only necessary on activities that are entry points for your application. However, 
setting the application on each Activity has no negative impact and ensures that the SDK always has the 
necessary reference to your application. We recommend that you call setApplication in each of your
activities. 

4. In the onPause function, pause the lifecycle data collection.

   @Override 
   public void onPause() { 
      MobileCore.lifecyclePause(); 
   } 

To ensure accurate session and crash reporting, this call must be added to every activity. 
Tracking app crashes in Android 
This information helps you understand how crashes are tracked and the best practices to handle false crashes. 
Important: App crashes are tracked as part of lifecycle metrics. Before you can track crashes, add the library to 
your project. 

When lifecycle metrics are implemented, a call is made to 
MobileCore.lifecycleStart(additionalContextData) in the OnResume method of each activity. In the
onPause method, a call is made to MobileCore.lifecyclePause(). In the MobileCore.lifecyclePause()
method, a flag is set to indicate a graceful exit. When the app is launched again or resumed, 
MobileCore.lifecycleStart(additionalContextData) checks this flag. If the app did not exit successfully
as determined by the flag status, an a.CrashEvent context data is sent with the next call, and a crash event is
reported. 
Important: To ensure accurate crash reporting, you must call lifecyclePause() in the onPause method of
each activity. 
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TRACKING SCREENS AND ACTIONS 
You may use the trackState and trackAction APIs in order to start measuring your user's engagement with your 
app. 
States represent screens or views in your app. Each time a new state is displayed in your application, for 
example, when a user navigates from the home page to the news feed, the trackState API may be called. This 
method sends an Analytics state tracking hit (equivalent of a page view) with optional context data. 
Actions are events that occur in your app. Use the trackAction API to track and measure an action. Each action 
has one or more corresponding metrics that are incremented each time the event occurs. For example, you 
might call this API for each new subscription each time an article is viewed, or each time a level is completed. 
**The sections detailed below provide general guidelines for using context data to collect custom variable 
requirements on screens and actions. These sections should be built out according to your client’s specified tracking 
requirements.  

DEPLOYMENT INSTRUCTIONS FOR SCREEN TRACKING 

Screen Tracking (similar to pages in web) 
You should use the “trackState” API in order to start measuring your app’s screens. States represent screens or 
views in your app. Each time a new state is displayed in your application, for example, when a user navigates 
from the home page to the product details page, then trackState API may be called. This method sends an 
Analytics state tracking hit (equivalent of a page view) with optional context data. In Android, trackState is 
typically called each time a new activity is loaded. 
Syntax  
public static void trackState(final String state, final Map<String, String> contextData) 

Code Example for adding a value for “pageName”: 
Map<String, String> additionalContextData = new HashMap<String, String>();
additionalContextData.put("customKey", "value");
MobileCore.trackState("app:us:en:homePage", additionalContextData); 

Code Example for capturing site section and site sub-section along with the pageName variable on the home 
page:  
Map<String, String> additionalContextData = new HashMap<String, String>();
additionalContextData.put("app.retail.section", "home");  
additionalContextData.put("app.retail.subSection1", "promoBanners");
MobileCore.trackState("app:us:en:homePage", additionalContextData); 

DEPLOYMENT INSTRUCTIONS FOR ACTION TRACKING 

Action Tracking (similar to trackLink/success event tracking in web) 

NOTE 
• The “state” value in the “trackState” API represents the “pageName” value. If you want to set and

eVar or a prop with the page/screen name, then this can be done using the custom context data
variable or using processing rules.
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You should use the “trackAction” API in order to measure your user’s engagement inside your app’s screens. 
Action represents any micro/macro conversion event that you want to track. Ex: Registrations Complete & Cart 
Additions. 
Syntax  
public static void trackAction(final String action, final Map<String, String> contextData) 

Code Example for tracking a click on the Login button: 
Map<String, String> additionalContextData = new HashMap<String, String>(); 
additionalContextData.put("customKey", "value"); 
MobileCore.trackAction("loginClicked", additionalContextData); 

Code Example for capturing language and country code along with the login clicked action: 
Map<String, String> additionalContextData = new HashMap<String, String>();
additionalContextData.put("app.retail.loginType", "FB");  
additionalContextData.put("app.retail.countrycode", "US");
MobileCore.trackAction("loginClicked", additionalContextData); 

MAPPING CONTEXT DATA VARIABLES 
With the AEP SDK, context data variables must be mapped to the eVars, props and events as defined in the 
implementation solutions. In the examples above, Language and Country Code would need to be mapped to 
assigned eVars via the Adobe Analytics Processing Rules interface in order to report on and view the data.  

Learn more about Processing Rules at 
https://marketing.adobe.com/resources/help/en_US/reference/processing_rules.html 

https://marketing.adobe.com/resources/help/en_US/reference/processing_rules.html
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SOLUTION COMPONENTS 

SITE CONTENT EFFECTIVENESS 

This solution allows the clients to evaluate the effectiveness of the app’s pages, including their influence on 
conversion, landing page, bounce rate and exit rate as well as gives marketers the ability to drill down on each 
level of your app hierarchy.  To do that, it requires that every page/screen of the app be tagged with an effective 
page name and variables to represent each level of the content hierarchy.  

VARIABLES IN THIS SECTION 
The below table consists of variables used for this solution. 
Analytics Variable Used For Context Data Variable 

pageName Pages N/A (argument of trackState call) 
prop5 Language cmf.app.pageLanguage 
prop7 Time Zone cmf.app.userTimeZone 
prop21 Media Name cmf.app.mediaName 
eVar1 Application ID cmf.app.applicationID 
eVar7 Page Name cmf.app.pageName 
eVar21 Media Name cmf.app.mediaName 
eVar35 ECID cmf.app.ecid 
eVar36 User ID cmf.app.userID 
event34 App Page Views cmf.app.appPageView 

DEPLOYMENT INSTRUCTIONS 

CONTEXT DATA - ALL SCREENS 
Set the following context data variables on every screen and trigger a 'trackState' call (typically on load of every 
screen): 

Context Data Variable Notes 
pageName (argument of trackState 
call) 

Set a clear, descriptive page name. Consider including the type or 
category of page to start the page name. Continue the page name with 
each level of the site hierarchy until the final descriptive portion of the 
page. Use a pipe "|" or ":" as the delimiter between each portion of the 
pageName. 

cmf.app.pageName Set a clear, descriptive page name. Consider including the type or 
category of page to start the page name. Continue the page name with 
each level of the site hierarchy until the final descriptive portion of the 
page. Use a pipe "|" or ":" as the delimiter between each portion of the 
pageName. 
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cmf.app.pageLanguage Set this variable to the language of the page. Use two letter code for 
language. Example: “en” for English, “fr” for French etc. 

cmf.app.userTimeZone Set this variable to the time zone of the user browsing the app. 
cmf.app.mediaName Set this variable to media name. The media name should be 

descriptive and clear and should depict the media/content served by 
your website. For example: “Maths Experiments”, “Multiplayer game” 
etc. 

cmf.app.applicationID Set this variable to the application ID which will be provided by CMF. 
For example: “1314.12112.134933” 

cmf.app.ecid Set this variable to the Experience Cloud ID set by the app. Use the 
“getExperienceCloudId” API as explained below to populate this 
variable. 

cmf.app.userID Set this variable to a custom visitor ID if the user is logged in or if there 
is any other way to identify the user uniquely. For example: “US1234”, 
“QA1234” etc. If there is no such ID, then set it as “NA” 

cmf.app.appPageView Set this to 1. 

Page Naming Best Practice 

o Context - Include the directory structure or content hierarchy in the page name to help users understand
where the page "lives" within the site.  This also allows for simplified report filtering.

o Clarity - Ensure the page name is clear and easily identifiable for infrequent users.  This will promote
faster adoption of Adobe Analytics by business users and also allow for easier, more efficient reporting.

o Conciseness - Keep the page name as short as possible to maximize limited character space.  This is also
important for clean, simple reports but should not take precedence over context and clarity.

getExperienceCloudId 

This API retrieves the ECID that was generated when the app was initially launched and is stored in the ECID 
Service. 
This ID is preserved between app upgrades, is saved and restored during the standard application backup 
process and is removed at uninstall. The values are returned via the callback. 
When AdobeCallbackWithError is provided, and you are fetching the ECID from the Mobile SDK, the timeout 
value is 500ms. If the operation times out or an unexpected error occurs, the fail method is called with the
appropriate AdobeError. 
Syntax: 
public static void getExperienceCloudId(final AdobeCallback<String> callback); 

o callback is invoked after the ECID is available.
Example:

Identity.getExperienceCloudId(new AdobeCallback<String>() {    
@Override    

https://aep-sdks.gitbook.io/docs/using-mobile-extensions/mobile-core/mobile-core-api-reference#adobecallbackwitherror
https://aep-sdks.gitbook.io/docs/using-mobile-extensions/mobile-core/mobile-core-api-reference#adobeerror


19 | Adobe Marketing Cloud Tech Spec – AEP SDK 

    public void call(String id) {
//Handle the ID returned here    

    } 
});

Context Data Format: 
Map<String, String> contextData = new HashMap<String, String>(); 
contextData.put("cmf.app.pageName", "<Page Name>"); 
contextData.put("cmf.app.pageLanguage", "<Page Language>"); 
contextData.put("cmf.app.userTimeZone", "<User Time Zone>"); 
contextData.put("cmf.app.mediaName", "<Media Name>"); 
contextData.put("cmf.app.applicationID", "<Application ID>"); 
contextData.put("cmf.app.ecid", "<ECID>"); 
contextData.put("cmf.app.userID", "<User ID>"); 
contextData.put("cmf.app.appPageView", "<Set to 1>"); 
MobileCore.trackState("<Page Name>", contextData); 

Context Data Example: 
Map<String, String> contextData = new HashMap<String, String>(); 
contextData.put("cmf.app.pageName", "xyz|home"); 
contextData.put("cmf.app.pageLanguage", "en"); 
contextData.put("cmf.app.userTimeZone", "America/New York"); 
contextData.put("cmf.app.mediaName", "xyz media abc"); 
contextData.put("cmf.app.applicationID", "1314.12112.134933"); 
contextData.put("cmf.app.ecid", "243435354674744847484848"); 
contextData.put("cmf.app.userID", "US1234"); 
contextData.put("cmf.app.appPageView", "1"); 
MobileCore.trackState("xyz|home", contextData); 

CREATE PROCESSING RULES 
Create the following Processing Rules in for below variables to be set with corresponding context data values if 
corresponding context data exists: 
Variable Name Context Data 
pageName Pages N/A (argument of trackState call) 
prop5 Language cmf.app.pageLanguage 
prop7 Time Zone cmf.app.userTimeZone 
prop21 Media Name cmf.app.mediaName 
eVar1 Application ID cmf.app.applicationID 
eVar7 Page Name cmf.app.pageName 
eVar21 Media Name cmf.app.mediaName 
eVar35 ECID cmf.app.ecid 
eVar36 User ID cmf.app.userID 
event34 App Page Views cd.appPageView
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MEDIA TRACKING 

This section describes the data layer to be added on the certain actions when the Media is engaged by the user. 

VARIABLES IN THIS SECTION 
The below table consists of variables used for this solution. 

Analytics Variable Used For Context Data Variable 

eVar1 Application ID cmf.app.applicationID 
eVar7 Page Name cmf.app.pageName 
eVar24 Media (Video/ Audio) Name cmf.app.mediaPlayedName 
eVar25 Media Format cmf.app.mediaFormat 
eVar26 Media Type cmf.app.mediaType 
eVar27 Media Genre cmf.app.mediaGenre 
eVar36 User ID cmf.app.userID 
event24 Media Start cmf.app.mediaStart 
event25 Media Complete 25% cmf.app.media25 
event26 Media Complete 50% cmf.app.media50 
event27 Media Complete 75% cmf.app.media75 
event28 Media Complete 100% cmf.app.mediaComplete 
list1 Media Information cmf.app.mediaInformation 

DEPLOYMENT INSTRUCTIONS 

CONTEXT DATA 
Set the following context data variables on media engagements on play, 25% completion, 50% completion, 75% 
completion and 100% completion and trigger a 'trackAction' call: 

Context Data Variable Notes 
cmf.app.applicationID Set this variable to the application ID which will be provided by CMF. 

For example: “1314.12112.134933” 
cmf.app.pageName Set a clear, descriptive page name. Consider including the type or 

category of page to start the page name. Continue the page name 
with each level of the site hierarchy until the final descriptive portion 
of the page. Use a pipe "|" or ":" as the delimiter between each portion 
of the pageName. 

cmf.app.mediaPlayedName Set this variable with Media (audio/ video) played name. For example: 
“Education Guidelines” 

cmf.app.mediaFormat Set this variable with Media format. For example: Feature Film, 
Feature Length Documentary, Mini-Series, MOW, One-off, Pilot, Series 
etc. 
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cmf.app.mediaType Set this variable with Media type. For example: Live Action, Animation, 
Both Live Action and Animation etc. 

cmf.app.mediaGenre Set this variable with Media genre. For example: Education, Kids, 
Thriller, Horror etc. 

cmf.app.userID Set this variable to a custom visitor ID if the user is logged in or if there 
is any other way to identify the user uniquely. For example: “US1234”, 
“QA1234” etc. If there is no such ID, then set it as “NA” 

cmf.app.mediaStart Set this to 1 when media (audio/ video) is started 
cmf.app.media25 Set this to 1 when media (audio/ video) completes 25% 
cmf.app.media50 Set this to 1 when media (audio/ video) completes 50% 
cmf.app.media75 Set this to 1 when media (audio/ video) completes 75% 
cmf.app.mediaComplete Set this to 1 when media (audio/ video) completes 100% 
cmf.app.mediaInformation Set this variable with Media information - season, episode number of 

the Media, episode name – concatenated by “|”. For example: 
“S02|E11|Education Guidelines” 

Context Data Format for media start: 
Map<String, String> contextData = new HashMap<String, String>(); 
contextData.put("cmf.app.applicationID", "<Set this to application ID>"); 
contextData.put("cmf.app.pageName", "<Set this to page name>"); 
contextData.put("cmf.app.mediaPlayedName", "<Set this to name of video/audio>"); 
contextData.put("cmf.app.mediaFormat", "<Set this to media format>"); 
contextData.put("cmf.app.mediaType", "<Set this to media type>"); 
contextData.put("cmf.app.mediaGenre", "<Set this to media genre>"); 
contextData.put("cmf.app.mediaInformation", "<Set this to media information>"); 
contextData.put("cmf.app.userID ", "<Set this to User ID>"); 
contextData.put("cmf.app.mediaStart", "<Set this to 1>"); 
MobileCore.trackAction("<Video/ Audio Start>", contextData); 

Context Data Format for media start: 
Map<String, String> contextData = new HashMap<String, String>(); 
contextData.put("cmf.app.applicationID", "1314.12112.134933"); 
contextData.put("cmf.app.pageName", "home:categories:xyz series:season1"); 
contextData.put("cmf.app.mediaPlayedName", "Education Guidelines"); 
contextData.put("cmf.app.mediaFormat", "Feature Length Documentary"); 
contextData.put("cmf.app.mediaType", "Animation"); 
contextData.put("cmf.app.mediaGenre", "Education"); 
contextData.put("cmf.app.mediaInformation", "S02|E11|Education Guidelines"); 
contextData.put("cmf.app.userID ", "US1234"); 
contextData.put("cmf.app.mediaStart", "1"); 
MobileCore.trackAction("Video Start", contextData); 

Context Data Format for media complete 25%: 
Map<String, String> contextData = new HashMap<String, String>(); 
contextData.put("cmf.app.applicationID", "<Set this to application ID>"); 
contextData.put("cmf.app.pageName", "<Set this to page name>"); 
contextData.put("cmf.app.mediaPlayedName", "<Set this to name of video/audio>"); 
contextData.put("cmf.app.mediaFormat", "<Set this to media format>"); 
contextData.put("cmf.app.mediaType", "<Set this to media type>"); 
contextData.put("cmf.app.mediaGenre", "<Set this to media genre>"); 
contextData.put("cmf.app.mediaInformation", "<Set this to media information>"); 
contextData.put("cmf.app.userID ", "<Set this to User ID>"); 
contextData.put("cmf.app.media25", "<Set this to 1>"); 
MobileCore.trackAction("<Video/ Audio Start>", contextData); 

Context Data Example for media complete 25%: 
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Map<String, String> contextData = new HashMap<String, String>(); 
contextData.put("cmf.app.applicationID", "1314.12112.134933"); 
contextData.put("cmf.app.pageName", "home:categories:xyz series:season1"); 
contextData.put("cmf.app.mediaPlayedName", "Education Guidelines"); 
contextData.put("cmf.app.mediaFormat", "Feature Length Documentary"); 
contextData.put("cmf.app.mediaType", "Animation"); 
contextData.put("cmf.app.mediaGenre", "Education"); 
contextData.put("cmf.app.mediaInformation", "S02|E11|Education Guidelines"); 
contextData.put("cmf.app.userID ", "US1234"); 
contextData.put("cmf.app.media25", "1"); 
MobileCore.trackAction("Video Start", contextData); 

Context Data Format for media complete 50%: 
Map<String, String> contextData = new HashMap<String, String>(); 
contextData.put("cmf.app.applicationID", "<Set this to application ID>"); 
contextData.put("cmf.app.pageName", "<Set this to page name>"); 
contextData.put("cmf.app.mediaPlayedName", "<Set this to name of video/audio>"); 
contextData.put("cmf.app.mediaFormat", "<Set this to media format>"); 
contextData.put("cmf.app.mediaType", "<Set this to media type>"); 
contextData.put("cmf.app.mediaGenre", "<Set this to media genre>"); 
contextData.put("cmf.app.mediaInformation", "<Set this to media information>"); 
contextData.put("cmf.app.userID ", "<Set this to User ID>"); 
contextData.put("cmf.app.media50", "<Set this to 1>"); 
MobileCore.trackAction("<Video/ Audio Start>", contextData); 

Context Data Example for media complete 50%: 
Map<String, String> contextData = new HashMap<String, String>(); 
contextData.put("cmf.app.applicationID", "1314.12112.134933"); 
contextData.put("cmf.app.pageName", "home:categories:xyz series:season1"); 
contextData.put("cmf.app.mediaPlayedName", "Education Guidelines"); 
contextData.put("cmf.app.mediaFormat", "Feature Length Documentary"); 
contextData.put("cmf.app.mediaType", "Animation"); 
contextData.put("cmf.app.mediaGenre", "Education"); 
contextData.put("cmf.app.mediaInformation", "S02|E11|Education Guidelines"); 
contextData.put("cmf.app.userID ", "US1234"); 
contextData.put("cmf.app.media50", "1"); 
MobileCore.trackAction("Video Start", contextData); 

Context Data Format for media complete 75%: 
Map<String, String> contextData = new HashMap<String, String>(); 
contextData.put("cmf.app.applicationID", "<Set this to application ID>"); 
contextData.put("cmf.app.pageName", "<Set this to page name>"); 
contextData.put("cmf.app.mediaPlayedName", "<Set this to name of video/audio>"); 
contextData.put("cmf.app.mediaFormat", "<Set this to media format>"); 
contextData.put("cmf.app.mediaType", "<Set this to media type>"); 
contextData.put("cmf.app.mediaGenre", "<Set this to media genre>"); 
contextData.put("cmf.app.mediaInformation", "<Set this to media information>"); 
contextData.put("cmf.app.userID ", "<Set this to User ID>"); 
contextData.put("cmf.app.media75", "<Set this to 1>"); 
MobileCore.trackAction("<Video/ Audio Start>", contextData); 

Context Data Example for media complete 75%: 
Map<String, String> contextData = new HashMap<String, String>(); 
contextData.put("cmf.app.applicationID", "1314.12112.134933"); 
contextData.put("cmf.app.pageName", "home:categories:xyz series:season1"); 
contextData.put("cmf.app.mediaPlayedName", "Education Guidelines"); 
contextData.put("cmf.app.mediaFormat", "Feature Length Documentary"); 
contextData.put("cmf.app.mediaType", "Animation"); 
contextData.put("cmf.app.mediaGenre", "Education"); 
contextData.put("cmf.app.mediaInformation", "S02|E11|Education Guidelines"); 
contextData.put("cmf.app.userID ", "US1234"); 
contextData.put("cmf.app.media75", "1"); 
MobileCore.trackAction("Video Start", contextData); 
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Context Data Format for media complete 100%: 
Map<String, String> contextData = new HashMap<String, String>(); 
contextData.put("cmf.app.applicationID", "<Set this to application ID>"); 
contextData.put("cmf.app.pageName", "<Set this to page name>"); 
contextData.put("cmf.app.mediaPlayedName", "<Set this to name of video/audio>"); 
contextData.put("cmf.app.mediaFormat", "<Set this to media format>"); 
contextData.put("cmf.app.mediaType", "<Set this to media type>"); 
contextData.put("cmf.app.mediaGenre", "<Set this to media genre>"); 
contextData.put("cmf.app.mediaInformation", "<Set this to media information>"); 
contextData.put("cmf.app.userID ", "<Set this to User ID>"); 
contextData.put("cmf.app.mediaComplete", "<Set this to 1>"); 
MobileCore.trackAction("<Video/ Audio Start>", contextData); 

Context Data Example for media complete 100%: 
Map<String, String> contextData = new HashMap<String, String>(); 
contextData.put("cmf.app.applicationID", "1314.12112.134933"); 
contextData.put("cmf.app.pageName", "home:categories:xyz series:season1"); 
contextData.put("cmf.app.mediaPlayedName", "Education Guidelines"); 
contextData.put("cmf.app.mediaFormat", "Feature Length Documentary"); 
contextData.put("cmf.app.mediaType", "Animation"); 
contextData.put("cmf.app.mediaGenre", "Education"); 
contextData.put("cmf.app.mediaInformation", "S02|E11|Education Guidelines"); 
contextData.put("cmf.app.userID ", "US1234"); 
contextData.put("cmf.app.mediaComplete", "1"); 
MobileCore.trackAction("Video Start", contextData); 

CREATE PROCESSING RULES 
Create the following Processing Rules in for below variables to be set with corresponding context data values if 
corresponding context data exists: 
Variable Name Context Data 
eVar1 Application ID cmf.app.applicationID 
eVar7 Page Name cmf.app.pageName 
eVar24 Media (Video/ Audio) Name cmf.app.mediaPlayedName 
eVar25 Media Format cmf.app.mediaFormat 
eVar26 Media Type cmf.app.mediaType 
eVar27 Media Genre cmf.app.mediaGenre 
eVar36 User ID cmf.app.userID 
event24 Media Start cmf.app.mediaStart 
event25 Media Complete 25% cmf.app.media25 
event26 Media Complete 50% cmf.app.media50 
event27 Media Complete 75% cmf.app.media75 
event28 Media Complete 100% cmf.app.mediaComplete 
list1 Media Information cmf.app.mediaInformation 
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SHOPPING CART 

This solution allows the clients to evaluate the effectiveness of the shopping cart. 

VARIABLES IN THIS SECTION 
The below table consists of variables used for this solution. 

Analytics Variable Used For Context Data Variable 

pageName Pages N/A (argument of trackState call) 
eVar1 Application ID cmf.app.applicationID 
eVar7 Page Name cmf.app.pageName 
products Products Set directly in Products Syntax 
purchaseID Deduplication of Purchases cmf.app.purchaseID 
eVar34 Order ID cmf.app.purchaseID 
evar35 ECID cmf.app.ecid 
eVar36 User ID cmf.app.userID 
purchase Orders Set directly in Products Syntax 
purchase Units Set directly in Products Syntax 
purchase Revenue Set directly in Products Syntax 
event1 Total Revenue cmf.app.orderRevenue 

DEPLOYMENT INSTRUCTIONS 

CONTEXT DATA 
Set the following context data variables on order confirmation and trigger a 'trackAction' call: 

Context Data Variable Notes 
cmf.app.applicationID Set this variable to the application ID which will be provided by CMF. 

For example: “1314.12112.134933” 
cmf.app.pageName Set a clear, descriptive page name. Consider including the type or 

category of page to start the page name. Continue the page name 
with each level of the site hierarchy until the final descriptive portion 
of the page. Use a pipe "|" or ":" as the delimiter between each portion 
of the pageName. 

cmf.app.purchaseID Set the value to the unique order ID for the order (such as the user's 
confirmation number). The order ID is alphanumeric with a limit of 20 
characters, which must be unique for the rest of the life of the report 
suite 

cmf.app.userID Set this variable to a custom visitor ID if the user is logged in or if there 
is any other way to identify the user uniquely. For example: “US1234”, 
“QA1234” etc. If there is no such ID, then set it as “NA” 



25 | Adobe Marketing Cloud Tech Spec – AEP SDK 

cmf.app.orderRevenue This should reflect total revenue for the order (before shipping, 
discount and taxes) 

cmf.app.ecid Set this variable to the Experience Cloud ID set by the app. Use the 
“getExperienceCloudId” API as explained below to populate this 
variable. 

&&products It’s a special products string which contain multiple information. The 
format of string is 
“Category;Product;Quantity;Price[,Category;Product;Quantity;Price]”. 
Category represents the product category. 
Product represent Product SKU – Product IDs should be unique 
identifiers of individual products, such as a product SKU. 
Quantity represents the total number of units purchased for that 
specific product. 
Price - This should reflect the revenue (unit price) for that item (before 
shipping, discount and taxes). 

Context Data Format for order confirmation: 
Map<String, String> contextData = new HashMap<String, String>(); 
contextData.put("cmf.app.pageName", "<Page Name>"); 
contextData.put("cmf.app.applicationID", "<Application ID>"); 
contextData.put("cmf.app.ecid", "<ECID>"); 
contextData.put("cmf.app.userID", "<User ID>"); 
contextData.put("&&products", "Category;Product;Quantity;Price[,Category;Product;Quantity;Price]"); 
contextData.put("cmf.app.purchaseID", "<Purchase ID>"); 
contextData.put("cmf.app.orderRevenue", "<Order Revenue>"); 
MobileCore.trackAction("<Order Confirmed>", contextData); 

Context Data Example for order confirmation: 
Map<String, String> contextData = new HashMap<String, String>(); 
contextData.put("cmf.app.pageName", "order confirmed"); 
contextData.put("cmf.app.applicationID", "1314.12112.134933"); 
contextData.put("cmf.app.ecid", "243435354674744847484848"); 
contextData.put("cmf.app.userID", "us1234"); 
contextData.put("&&products", ";XYZ-100087613;1;69.95,;XYZ-53215652;10;29.99"); 
contextData.put("cmf.app.purchaseID", "1234567890"); 
contextData.put("cmf.app.orderRevenue", "99.94"); 
MobileCore.trackAction("Order Confirmed", contextData); 

CREATE PROCESSING RULES 
Create the following Processing Rules in for below variables to be set with corresponding context data values if 
corresponding context data exists: 
Variable Name Context Data 
pageName Pages N/A (argument of trackState call) 
eVar1 Application ID cmf.app.applicationID 
eVar7 Page Name cmf.app.pageName 
products Products Set directly in Products Syntax 
purchaseID Deduplication of Purchases cmf.app.purchaseID 
eVar34 Order ID cmf.app.purchaseID 
evar35 ECID cmf.app.ecid 
eVar36 User ID cmf.app.userID 
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purchase Orders Set directly in Products Syntax 
purchase Units Set directly in Products Syntax 
purchase Revenue Set directly in Products Syntax 
event1 Total Revenue cmf.app.orderRevenue 
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APPENDIX: VALIDATION 

DEBUGGING AND TESTING TOOLS 

Adobe Consulting uses a variety of tools to unit test Adobe Analytics code on any given mobile app.  We 
recommend that clients should use at proxying tool as well, like Charles: 

• Charles Web Debugging Proxy [http://www.charlesproxy.com]

To test the Mobile SDK implementation, it is recommended to install the mobile app on a mobile device and 
test Marketing Cloud functionality in real time while performing actions within the app. In order to do this, you 
must use a proxy monitoring tool and proxy the device to your computer via a proxy.  
The following steps indicate how to proxy an iOS device to your machine via Charles Proxy monitoring tool:*  
Notes: the mobile device must be on the same network as the computer running the proxy monitoring tool. Be 
aware that some corporate networks may block the use of such proxying tools. In order to ensure 
comprehensive testing, it is recommended that SSL is disabled in the ADBMobileConfig.JSON file for your pre-
production builds.  

• Navigate to Settings > Wi-Fi.
• Click the blue "i" icon to the right of your currently selected Wi-Fi network.
• Scroll to the HTTP Proxy settings.
• Select Manual.
• Enter the IP Address that your laptop/workstation is currently using for Wi-Fi connectivity (in

Charles, this is found by clicking Help > Local IP Address)
• Click Home.
• Launch the application and verify that hits from the mobile device are currently appearing in

Charles Proxy. The first time you proxy a device, you will be shown a popup in Charles asking to
accept the incoming connection. Click yes.

http://www.charlesproxy.com/
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